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1

General Notes

MIE versions
The MIE (Mobi Info Edit) software is a text editing software developed by Mobitec. It provides an easy
and dynamic way of editing text and graphics which will be presented in a Mobitec information system.
MIE is available in two versions, as Basic and as Advanced version. Main difference is the type of system the data is edited for. The Basic version is used for destination sign systems (or Basic Systems). In a
basic system all information is selected manually from the bus driver and doesn’t change along the route.
Typically this would be destination text and route number shown on destination signs faced to the outside
of the bus. The Advanced version is used to setup data for a complete route information system including
automatic vehicle localisation via GPS or tachometer signal. The driver has to start the route, all information changes will be initiated automatically based on bus localisation and a preprogrammed route system. Please refer to the system manuals for further information.

Notes to the user
Since MIE software is under a continuous updating process, information in this manual is subject to
change without prior notice. The actual installed revision of MIE3 can be checked in by activating the
‘About MIE’ window in the ‘Help’ menu.

Used Symbols
Warning!
Identifies a dangerous situation. If you do not avoid this, it can cause personal injury.
Caution!
Identifies a situation that could have an influence on the product quality, the warranty conditions
or could lead to data loss.
Note!
Identifies useful information in factual connection and notes that need to be followed.

Legal Notes / Safety
MIE is a powerful software offering a wide range of possibilities to layout the signs. The software is designed to fulfil the needs of the international markets. Some of the offered functionality might not comply
to regional laws or best practice. Please consider this when designing the layout, especially when choosing colours, font shapes, font sizes, text effects like scrolling etc.
Mobitec will not take any responsibility if the editing don’t comply to regional laws. Please contact
Mobitec if a function needed for legal compliance is not offered by the MIE software.

Please be aware that certain layout elements might disturb other traffic participants. Mobitec will
not take any responsibility if the chosen layout negatively influences the traffic.
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2

Installation

2.1

System Requirements

Minimum system requirements:
•
•

Windows XP
Microsoft .NET 2.0 Framework

Minimum requirements hardware:
•
•
•
•

Pentium 800 MHz processor
256 MB RAM
20 GB hard drive
USB Port

Recommended hardware capacity:
•
•
•
•

Pentium 1,4 GHz processor
1 GB RAM
20 GB hard drive
USB Port

2.2

First Installation

To install MIE on a computer the first time, execute the setup.exe file and follow the instructions. On the
font selection window appearing during the installation, select the fonts applicable for your region or, if
no specific font library exists, the standard libraries on top of the selection. If you got a customized font
package together with your MIE copy please select ‘Font package provided by Mobitec’ and specify the
path to the font package file. The font package file is always in .zip format.

2.3

Updating MIE3

If you want to update MIE3 to a newer version, please do not uninstall the previous version from your
computer. Just start the new installation by executing the setup file. The installation routine will automatically recognize a previous version and handle the update. This ensures all MIE settings done to customize the software will be kept in the new version.

If an existing MIE3 software is uninstalled all customized settings will be lost.
Databases and customized font files will always be kept

2.4

Uninstalling MIE3

MIE 3 is uninstalled from the control panel in Windows. Fonts, databases and a some configuration files
are not deleted. These has to be deleted manually. To delete these files, please delete the entire MIE
directory after uninstallation.
If you plan to reinstall MIE on the same computer at a later stage again, it is recommended to
keep the files not uninstalled by the uninstallation routine. They contain the most important data
that has been generated with the MIE software.
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2.5

Licence Management

To get full function of the MIE software you need a licence key. Contact your local dealer to obtain one.
The licence key is delivered in a file format (.mlk) and cannot be opened, to install it on your computer
follow these steps:
1.

Copy the file and place it on the desktop (or any other user folder)

2.

Start the MIE software

3.

In menu “Help/Licence management” click on the tab “Read from file”

4.

Search the file with the browser and double click on it

5.

Click on OK and restart the MIE software

After licensing the mlk file is no longer needed and can be removed.
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The graphical user interface

Bus Config
Templates

FastInput

Sign Area

Rotations

The user interface of MIE3 Basic is divided into several areas. The areas can partly be customized as
described below. MIE3 remembers done customizations and restores these when opening.

Program Area

Function of the areas is described further down in the manual in the respective chapters.
•

•

•

•

•

Sign Area:
Presentation of all signs activated in the Bus Config area. The signs can be zoomed in and out via
right-click or with the mouse by left-clicking in one of the sign corners and then moving the mouse.
Signs can be moved by click and move in the title bar of the sign window. If a sign is outside the visible area, a scroll bar appears on the right side of the MIE3 window. Signs can be rearranged horizontally and vertically at any time in the ‘Window’ menu.
Rotations window:
Showing all rotations of the activated sign. The rotations window is a dockable window. This means
it can be undocked from the application and freely moved on the desktop. To undock or dock the
window, double-click in the title bar. The window can be completely switched on or off in the ‘View’
menu.
FastInput window:
The FastInput mode offers a fast possibility of editing the signs. The FastInput window is a dockable
window. This means it can be undocked from the application and freely moved on the desktop. To
undock or dock the window, double-click in the title bar. The function can be activated/deactivated in
the ‘Tools’ menu.
Bus Config / Templates:
This area can be used to either show a list of buses and configured signs or a list of available templates. It can be switched by tabs on top of the area. The bus config window is used to activate /
deactivate signs in the sign area. The template window is used to check/change used templates.
Program Area:
Used to handle programs. The program area has a fixed width but the height can be changed by click
and move the top border to the sign area.
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4
4.1

Specifying the System
The Bus Configuration Wizard

The bus configuration wizards helps setting up the system environment. It automatically starts when MIE
is newly installed or can be opened with the toolbar icon:

The wizard automatically guides through the necessary steps to configure a bus system. The setup
menus are the same ones as in the manual setup described in the following chapters.
Step 1: Setting up a bus
In the first step enter a bus name and optional a bus type. Then press ‘Next’.
Step 2: Adding a sign to the bus
In the second step signs can be assigned to the bus. Click on the ‘+’ icon (Add sign to bus) to add a sign.
With the ‘-’ (Remove sign from bus) signs can be removed again.
If the required sign is not in the drop down list, press ‘Create sign’ next to the list. This opens a window to
setup sign details which is described in the Chapter ‘The sign Editor’.
Step 3: Setup sign properties
After the right sign type is selected, sign properties like address, position and template need to be assigned. Details can be found in the chapter ‘The bus editor’.
Step 4: Finish wizard
To setup several signs in a bus repeat steps 2 & 3 until all signs are defined. When the setup is complete, the wizard can be closed by clicking ‘Finish’.

After the bus configuration wizard has been used, you can directly start creating new programs
and editing text which is described in the following main chapters. The other sub chapters within
this main chapter are describing manual configuration or configuration change of the system.

4.2

The Sign editor

The Sign editor is the tool used for editing all types of signs into the system. For example sign types to
be used, text resolution etc.
The Sign editor is reached from the menu Option/
Sign Configuration or the toolbar icon:

The Sign Configuration editor presents an overview of all the signs which have been entered into
the system and which can be virtually placed in the
vehicle.
The ‘+’ and ‘-’ buttons above the sign table can be
used to add and remove signs from MIE.
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Window ‘Sign Details’:
When entering a new sign to the system, a Window pops up to enter following sign details:
•
•
•

Sign Name and check box ‘Set sign name automatic for new signs’:
This field is automatically assigned if the box at the end of the menu is checked. The box automatically unchecks as soon as the user enters an own sign name here.
Sign Configuration:
Choose the type of sign and for LED sign the used pitch.
Height and Width:
Set the resolution of the sign.

4.3

The Bus editor

The Bus editor is the tool used for editing all types of bus related information in the system. For example,
different combinations of signs and their placement in a bus. Each sign must have a dedicated system
address. Signs that have exactly the same resolution and the same function (e.g. route number signs)
only need to be defined once. The precondition is that these signs will be set to the same address.
The bus works like a container for the chosen signs.
The Bus editor is reached from the menu Option/
Bus Configuration or the toolbar icon:

This is where new buses are added, edited and
removed from the system. The Bus Configuration
editor gives an overview of the available buses
and signs in the system.
The ‘+’ and ‘-’ buttons above the Bus table can be
used to add and remove buses from MIE.
The ‘+’ and ‘-’ buttons above the Sign table can be
used to add and remove buses from the selected
bus.

Window ‘Signs in bus’:
When entering a new sign to the bus, a Window pops up to enter following sign details:
•
•
•
•

Sign and button ‘Create Sign’:
Dropdown box to select a sign defined in the MIE system. If the needed sign doesn’t appear in the
dropdown box, the button ‘Create sign’ offers a direct link to the Sign Configuration Editor.
Position:
Position where the sign is mounted in the bus.
Address and button ‘Suggest Address’:
Address of the sign. The button ‘Suggest Address’ sets an address automatically on base of the position and the Mobitec standard addressing.
Template/Template group:
Template of the layout of the sign. This defines how the information is displayed by standard when
entering new text. This could be a fixed template or a template group. Fixed templates are used
for direct text editing. For editing in Fast Input Mode or when importing from a file, template groups
should be set because these dynamically switch the template based on the information that’s actually used. For further information and examples on how the template groups work, please refer to the
chapter on Fast Input Mode.
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4.4

Sign templates

The sign layout is specified by a template. This defines used font and placement of each text part (e.g.
Destination, Line Number or via-text). Each specified field is represented by a colour:
Colour

Element

Type

yellow

Line Number

Digits/Letters to describe the line

green

Destination

Destination text

blue

via Stops

Stopnames of major stops on the route
Example:
This sign layout is represented by the following
template:

Sign templates are assigned to each specific sign
in a bus during system configuration. The defined
template is automatically used for each newly
generated program. It can be changed, however,
for each program independently in case a specific
program should have a different layout. This can
be done in the template tab in the lower left corner
of the software next to the bus tab.

Templates for a program should be changed before entering text. It is possible to change a
template in a program including text, this could lead to data loss, however, if the new template
includes less information than the previous one.
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5
5.1

Handling programs
Program definition

A program in the MIE editor is all information that defines the actual layouts on the system which can
include:
• Destination Text
• Via destination Text
• Route Number
• Route Symbol
The program includes all signs in the system and all rotations setup in the signs. Typically the program
number is equal with the destination number.

5.2

The program area

Program handling is done in the program area of the MIE workspace. This area shows a table of the
existing programs and includes the necessary controls.

Controls in the program area
Button/Menu

Program type:

Name

Function / Meaning

Add

Open dialogue box ‘Create new program’

Remove

Remove an existing program from the list. The control is greyed out as
long as no program is selected

Save

Save changes to an existing program. The control is greyed out as long
as no changes are done to the active program.

Undo

Undo unsaved changes. NOTE: The database will be set back to the
last saved version.
Switch between destinations and extra texts

To work with programs a sign in the bus has to be selected. Otherwise the controls are greyed
out.

02792_MIE3_Basic_eng
REV: R03_03.11.2014

www.mobitec.eu

12

MIE3 Basic

5.3

Create a new program

1.

Click the ‘+’ button in the program area.

2.

Add all needed information in the dialogue box ‘Create new program’.

3.

Click the Create button. The window closes and the work space becomes visible again.

4.

The new programme is activated and text can be entered.

5.

Save each sign individually after editing with the disc symbol in the program area.
It is not mandatory to save a program after editing. MIE will handle the program normally until it
is closed. When closing MIE warns that there are unsaved programs and offers the possibility to
save all.
A data loss of unsaved programs could occur, however, if the MIE software or the computer
crashes.
When opening the dialogue box MIE automatically
suggests a new free program number. This could
be changed by the user. MIE doesn’t allow over
writing an existing program. To replace an existing
program, this has to be deleted or moved first.
For bounded line numbers, the number could
directly be edited in the line number field. Alternatively the line number could also be edited later in
the number sign directly.

When a program is unbounded, no text can be entered or edited in the line number area of the
sign. The driver then chooses line number from the control unit in the bus.

5.4

Select (Mark) Programs

A program can be selected by clicking in the first column beside the program (see red mark).
To mark several programs:

5.5

•

To mark several programs in a row, use
the SHIFT key

•

To mark individual programs, use the
CTRL key

Delete a program

To activate the delete (–) button in the program area, a complete program has to be selected. After
pressing the – button, a dialogue box asks to confirm the deletion.
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5.6

Copy/Move programs

Complete programs can be copied or moved. This can be a big help when multiple similar destinations
have to be programmed or a new bus configuration should be added.
The program or several programs have to be selected. The commands for copying/moving can be found
in the ‘Edit’ Menu or by right click on the selected programs.

The Copy/Move program menu
Copy/Move to bus:
Choose the bus where the program should be
copied or moved to.
Start program number:
Set a program number to where the first selected
program should be copied/moved to.
Compress program number sequence (Standard):
If more than one program is selected, the programs will be copied in a continuous sequence,
e.g. if program #1 and #3 are copied to ‘start program number’ #5, the new programs will have the
numbers #5 and #6.
Keep internal order of program numbers (Only active when several programs are selected):
The programs are copied in a sequence keeping the original numbering order, e.g. if program #1 and #3
are copied to ‘start program number’ #5, the new programs will have the numbers #5 and #7.
Use same program number as in source bus (Only active is destination bus is different from source bus):
The copied programs will be given exactly the same numbers as the source programs.

Conflict Handling
If a number conflict occurs (program number
already occupied), the user can decide to copy/
move the selected programs to the next free program number(s) behind the selected start number
or to over write the existing programs.
If the checkbox ‘Apply for all conflicts’ is marked,
this selection will be remembered for all future
conflicts.

If ‘Apply for all conflicts’ is marked, There will be no more warnings in future when existing
programs will be over written by a copy/move action.

02792_MIE3_Basic_eng
REV: R03_03.11.2014

www.mobitec.eu

14

MIE3 Basic

6
6.1

Direct Text Editing
Basic Editing

To edit sign text, a cursor has to be set in the sign by clicking into the sign area. The user can now start
editing directly into the sign or use the Windows copy hotkeys (CTRL+C for copy, CTRL+V for paste) to
copy text from other applications.
The Windows copy hotkeys can also be used to copy text between the different signs.

To get an empty sign to edit, use the function ‘Create new program’.
There is an auto format function which continuously adapts the font size to the sign resolution during
editing. This function can be activated in the top toolbar by activating the button:
‘Autoformat continuously when entering text in sign’
This function works for English and Arabic texts. It only applies for directly edited data, not for text that is
copied into the sign.
Text with active autoformat function

Text without active autoformat function

A manual autoformat for any entry can be selected with the toolbar icon:
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6.2

Rotation handling

Below the sign area there is a set of controls to handle rotations.
Button/Menu

Function / Meaning
Showing the actually displayed rotation and the number of rotations in the actual
program and sign.
Move between the rotations with the arrow keys, unselectable keys (first or last rotation) are greyed out.
Add a rotation behind the actual one (‘Add rotation’)
Add a rotation before the actual one (‘Insert rotation’)
Remove actual rotation. The key is greyed out if only one rotation exists.

6.3

Changing Fonts

For each language a default set of fonts is preset. These fonts are used by all auto formatting functions.
It is possible at any time for the user to change a font to:
•

An installed Mobitec font

•

An installed Windows font
To change a font text has to be marked first. This
could be done by:
•
•

Double Click:					
Mark complete word
Place Cursor in text and press CTRL+A:		
Mark complete text

Now the font can be selected and changed with the icons in the font toolbar:

Icon

Name

Function

Dropdown Menu

Select preset font

Larger Font

Switch to larger preset font

Smaller Font

Switch to smaller preset font

Font Menu

Select any Mobitec or Windows font

Increase Spacing

Increase text spacing

Decrease Spacing

Decrease text spacing

Adaptation of the text spacing should always be done after the font selection. Otherwise it can
lead to malfunction.
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The Font menu
In the top part there is a list of all installed fonts.
Mobitec Fonts are listed above the system fonts.
The lower part shows a preview of the actual text.
Mobitec fonts are fixed in size and shape.

When choosing a Windows font, additionally controls for font size and font shape appear.

6.4

Layout Controls

The layout can additionally be controlled by moving or aligning text objects.
•

Alignment / Placement via Toolbar:
Place the cursor in the textobject and use following functions from the toolbar:

Icon

Function
Move active text with the arrow icons
Align text horizontal or vertical by selecting the placement

Text could also manually be moved by placing the
cursor into a text object and holding the CTRL key
down. The text object is marked now with a small
frame and can be moved with the mouse.
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6.5

Assigning Colours

In case the edited sign is a RGB sign (MobiLED colour), MIE offers different possibilities to use colours in
the layout of the display.
The toolbar to handle background colours gets active as soon as the cursor is placed into a RGB sign.
Setup the background colour via the ‘Background’ drop-down menu:
Button/Menu

Name

Function

Menu Background

Open dropdown menu to setup background colour

Unicolour background

Switch to a unicolour background

Background colour

Select background colour

Linear gradient

Switch to a linear, 2-colour gradient

Radial gradient

Switch to a radial 2-colour gradient

Second background
colour

Select second background colour

Delete background

Delete all background colours and gradients
Text colours and effects are changed in the
‘choose font’ menu explained before. As soon as a
marked text is written in a sign with colour capabilities, additional options appear in this menu.
The text colour can be set in the upper right corner
of the menu. Additional effects can be applied in
the ‘Font effects’ section.
The Sample window always shows an actual preview of the applied changes.
More Examples:
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7

Enhanced Text Editing features

7.1

The FastInput Mode

FastInput is a fast way of entering text into programs in MIE. FastInput make use of templates in order to
write data to signs. The data doesn’t have to be entered to each sign individually but into dedicated fields
reserved for line, destination text and via text.
The text will be written into all signs of a bus that are activated during the usage of FastInput. The format
and layout is automatically generated by using the template group specifications and the autoformat
function for text.
The result can be influenced by following settings:
•
•
•

Font mapping List
Adapt the fonts used by the autoformat function.
Autoformat options
Can be found under Options  Settings  Autoformatter
Template Specifications

7.2

Template Groups

When using FastInput MIE needs to dynamically layout the texts depending on the edited data. The layout needs to change depending on which data fields are required (like destination, line, via text). That’s
why the user doesn’t select a fixed template group including several templates.
Example:
Front Sign 24 x 200

Front Sign 24 x 200

Template Group Line Dest Via (on lower row)

Template Group Line Dest Via (as rotation)

After entering a destination, both signs switch to the template dest (destination only):

When adding a line number, both signs switch to the template line/dest (line number and destination)

When adding a via text, the front switches to two lined display, while the side adds a rotation:

02792_MIE3_Basic_eng
REV: R03_03.11.2014

www.mobitec.eu

19

MIE3 Basic

7.3

Entering FastInput Data

Data for FastInput is not entered in the signs directly but in the FastInput Window. The fields in this window are marked with the same colours as used in the template specifications.
When data is edited in one of the field it needs to be confirmed by pressing the ‘Enter’ or the ‘TAB’ key.
The cursor jumps to the next field (when available) in this case.
Fields that are not available in any of the used templates will also not be available in FastInput. For example, if non of the used template groups contain a ‘via’ field, it will not be possible to add a via destination in the FastInput window.
Rules on how MIE applies the data:
•
•
•
•

The edited data will be applied to all signs of a bus activated in the bus config area, also signs that
are not activated as visible.
It is possible to activate several buses, the program area then only lists programs that are saved in
all active buses.
MIE gives out a warning if a program code is already occupied in at least one of the buses. To check
or change this code, unselect all other buses. This will make the entry visible.
It is possible to manually change text generated by direct editing. These changes will be lost, however, as soon as a change in the FastInput window is done.

Example:
Edit Line Number ‘20’ and confirm with Enter.
The cursor jumps to the destination field.

Start editing the destination text. MIE will remember all previously entered texts and make suggestions.

Edit all needed texts fields. If ‘via’ is activated there
will always be an empty ‘via’ filed at the end. This
is to add new ‘via’ texts, it is not visible, however,
in the signs as long as it’s kept empty.
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7.4

Data Import Functions

MIE3 offers various possibilities to import data from Text or Excel files. This offers an easy and fast
startup, also for large data amounts. MIE can autoformat all fonts and layouts during the import. The
autoformat functions are the same as used for FastInput, so all signs need to be configured using appropriate template groups.

8
8.1

Verifying the programming
The ‘Show Rotations’ Window
A separate window can be opened that gives an
overview over all rotations in a sign already during
programming. The Window can be opened in the
‘View’ Menu by choosing ‘Show rotations’.
The Window is docked by standard to the right
side of the MIE user interface but can be undocked by clicking into the title bar and moving
the Window out. Then it can be freely placed on
the desktop independently from the MIE program
Window.
All rotations in a sign and program are shown. The
content of the window automatically updates when
changing the active sign or program.

8.2

The Bus Simulator

The bus simulator can be started by clicking on the icon:

The bus simulator is showing a list of all active
programs in the lower part. To run a simulation of
a specific program, activate it and press the Start
button.

The bus simulator shows a simulation of the edited program for first check of the editing. Since it
is not a full hardware emulation, differences to the real presentation on the sign might appear.
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9

Generating out-Files

After editing is completed, an out-file has to be generated to upload the information to the Mobitec information system. The Mobitec out file contains the complete customer setup that is generated in MIE.
To start generation of an out-File, click on the symbol:

Out-File generation step 1
Select the control unit type and the bus that should
be updated, then press:
•

Next to continue with step 2
OR

•

The link ‘Select all programs and jump to configuration step’ to skip step 2 and step 3.

Out-File generation step 2
In step 2 you can select the programs that should
be included or excluded from the out-file (single
arrows) or include/exclude all existing programs
(double arrow).
If this step was skipped in step 1 all programs will
be included.

Out-File generation step 3
In step 3 you can select the extra programs that
should be included or excluded from the out-file
(single arrows) or include/exclude all existing extra
programs (double arrow).
If this step was skipped in step 1 all extra programs will be included.
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Out-File generation step 4
In step 4 control unit settings can be adapted.
MIE is installed with common standard settings.
Changes will be remembered for future out-file
generations.
On the right side a file name can be set and via
the browse button (marked ‘..’) a path can be set
where to store the file. Standard path is C:\.

Out-File generation step 5
In step 5 the out file is generated. MIE shows a
report and a progress bar.
If no errors are reported, the out file can now be
found under the specified path. To upload to the
system this file has to be copied to an USB stick.
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10

Contact and Feedback

For further questions related to our products, delivery terms or services, please contact our head office in
Sweden or your area representative, which you will find on our website.
As we constantly strive to improve our products your point of view is very important for us, so please
don’t hesitate to send your comments via email to info@mobitec.eu.

SWEDEN
HEAD OFFICE

GERMANY

Mobitec AB

Mobitec GmbH

Box 97, Ölltorp Industriområde

Stockfeldstraße 1

52421 Herrljunga - Sweden

76347 Rastatt - Deutschland

Phone +46 513 229 00

Phone +49 7222 9297-40

Fax +46 513 107 22

Fax +49 72222 9297-418

info@mobitec.eu

info@mobitec.eu

BRAZIL

INDIA

Mobitec Brasil Ltda

CASTMASTER Mobitec Pvt Ltd

Rua João da Costa, 570

46 Industrial Estate, Sector 6

Bairro São Caetano

Faridabad 121006

Caxias do Sul RS - Brazil

Haryana - India

Phone: +55 54 320 985 00

Phone: +91 129 406 30 01

Fax: +55 54 320 985 40

Fax: +91 129 406 30 07

mobitec@mobitec.com.br

castmaster@castmaster.com

AUSTRALIA
Mobitec Australia Pty Ltd
Unit 1A/28 Skinner Ave
Riverwood NSW 2210 - Australien
Phone: +61 2 95 840-588
Fax: +61 2 95 840-788
destobob@bigpond.com.au

Please visit our website www.mobitec.eu where you will find detailed information about the Mobitec
group, our products, representative contacts, market areas and policies.
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